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CHAPTER 1

GETTING STARTED

Configuration Requirements
This design of experiment software package is written for the Windows™ 2000, XP and Vista
environment. The following system requirements are necessary to run DOE Wisdom:

! 486 PC with math coprocessor
! 5 MB disk space
! 8 MB RAM required, 16 MB RAM recommended
! Microsoft Windows™95 or greater

To Install on Windows
NOTE: You need administrator privileges to load the Vista version.  Once you have loaded the software,
you no longer need these privileges to run Wisdom

1. Start Windows™ 
2. Insert the DOE Wisdom installation disk into the CD-ROM drive (Note: The software

can also be downloaded from www.launsby.com. )  The automatic installation program
should begin.  If it does not start automatically, perform steps 3-5.

3. Click the Start button
4. Select Run and type D:\wisdom\2000-XP-Vista\setup.exe (Where D: is your CD

drives’s letter)
5. Click OK

To Start DOE Wisdom
1. Click the Start button.
2. Click Programs.
3. Click on the DOE Wisdom application

To Obtain Your Site Key
Note: When DOE Wisdom is loaded for the first time on a computer, it will run for only 15 days.  

1. Open DOE Wisdom and click on Help/License.  
2. A site code specific to your computer will appear.  
3. Send this site code to launsby@aol.com.  Launsby Consulting will then e-mail you the

site key for your computer.



Chapter 1: Getting Started

1-2

Enhanced Features
DOE Wisdom users who have used previous versions of this software will be impressed with the enhanced
capabilities.  These include:

• Wizard feature for Screening and Modeling designs.  Wizard allows users to choose
from template of most frequently used factors and responses specific to their process.
Wizard also generates a final report that summarizes entire experiment.

• Significant factors in the ANOVA are now highlighted automatically.
• Graphs for Residual Analysis.
• New Design Report screen that summarizes factors, factor levels, etc.
• D-optimal design check window that shows the tolerance value for each factor.
• Added options to the User Design screen to include the 2 and 3 way interactions in the

initial model.
• External documents folder that allows easy transfer of data between Wisdom and Excel,

Wisdom and Word and Wisdom and PowerPoint.

Project Window
When DOE Wisdom is opened for the first time, the following window appears:

Figure 1-1

In the “File name” section, enter the name of your first design.  Click on the Create button.  The Project
Window screen will appear.
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After the file has been created, the screen shown in Figure 1-2 will appear.  DOE Wisdom presents the user
with several views of the current project.  Each of these views is used to look at the project from a different
aspect, for example; the worksheet window views the design of the project in matrix form and  the graph
window can produce several different graphical views of the design, data, and analysis aspects of the
project.

The windows available depend on the status of the project.  The user always has a Message Log, Notes,
External Documents and Design folder available.  The Notes folder allows the user to enter any notes
regarding the experiment.  Operator, date data was collected, etc. could be recorded using this folder. When
a complete design has been entered, the Worksheet and Data windows also become available.  Finally,
when data is entered to complete the project the Graphics and Statistics windows are available.

                                    

                      
  

Figure 1-2

NOTE:
The toolbar may appear along the
top of the window.  You can leave
it on the top or drag it to the left
side as shown in this example.
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File Menu 
Click File on the menu bar.  The following options will appear:

Figure 1-3
The File Open dialog box allows the user to specify which file to open.  

Look in 
Select the drive in which DOE Wisdom stores the file that you want to open.
Select the directory in which DOE Wisdom stores the file that you want to open.
File Name
Type or select the filename you want to open.  This box lists files with the extension you select
in the Files of Type box.
Files of Type
Select the type of file you want to open:Wisdom Project (*.doe)
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The File Save dialog box allows the user to save changes to the current design.

The File Save As dialog box allows the user to specify the name and location of the file you’re about to
save.

File Name
To save a current project under a different name, type in the new filename.  
Save in
Select the drive in which you want to store the project.
Select the directory in which you want to store the project.

The File Properties section allows the user to set default values for the DOE Wisdom Projects.  Changing
the properties only affects new windows that will be brought up.  Those already created retain their
property settings.  When you select File Properties, the following window appears:

                 

Figure 1-4

The Project Tab allows the user to set the following for a given experiment or save settings as defaults
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for all experiments:

! Always on Top
! Show Tool Tips
! Track display windows with the Project window
! Track display windows with Windows Task Bar

The General Tab allows the user to set default values for DOE Wisdom items that apply to all or none
of the windows:

! Require a name for new projects
! New project on entry
! Open last project on entry

The Message Log Tab allows the user to set the following for a given experiment or save settings as
defaults:

! Set the number of messages displayed in the message log
! Display the following error levels in the message log:

Information
Warnings
Errors

The Design Report Tab allows the user to set the font used when generating this report.

The Design Check Tab allows the user to set the following for a given experiment or save settings as
defaults:

! Set the tolerance value warning level
! Select font attributes

The Worksheet Tab allows the user to set the following for a given experiment or save settings as
defaults:

! Show replicates as new columns
! Show replicates as new rows
! Use arrow keys for cell movement
! Use arrow keys for scrolling
! Select font attributes
! Display Trailing Zeros
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! Double space
! Print headings on all pages

The Data Tab allows the user to set the following for a given experiment or save settings as defaults:
! Show replicates as new columns
! Show replicates as new rows
! Use arrow keys for cell movement
! Use arrow keys for scrolling
! Select font attributes
! Display Trailing Zeros
! Double space
! Print headings on all pages

The Graphs Tab allows the user to set the following for a given experiment or save settings as defaults:
! Display Graph on Entry.  Following options are available:

Pareto
Scatter Plot
Main Effects
Interactions
Contour Plot
Response Surface
Residual Histogram
Residual Scatter Plot

! Display Edit Locations
! Select Font attributes
!

The Statistics Tab allows the user to set the following for a given experiment or save settings as defaults:

! Display Statistic on Entry.  The following statistics are available:
Analysis of Means
Analysis of Variance
Prediction Equation

! Display Edit locations
! Select Font attributes

The 1,2,3,4 command allows the user to open the last four projects that were closed.  Choose the number
that corresponds with the project you want to open.
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The Exit command allows the user to end the DOE Wisdom session.

View Menu
Click View on the menu bar.  The following options will appear:

Figure 1-5

The Project Tree command allows the user to display and hide the Project Tree.  The Project Tree shows
the views available and active for the current project.  A check mark appears next to the menu item when
the Project Tree is displayed.  When the Project Tree is displayed a screen similar to the one found in
Figure 1-6 will appear.

The Wizard command allows the user to go directly to the Wizard.

Figure 1-6 shows a list of all folders related to a particular project as displayed in the Project Window.  To
show or hide the folders, click the plus or minus sign beside the folder.  In the Project Window, locate the
folder you want and double click the left mouse button to open it.  Single click the left mouse button to
select a folder and then click the right mouse button.  This will allow you to select a new folder or to select
new properties for a particular folder.
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Figure 1-6

The Toolbar command allows the user to display and hide the Toolbar.  The Toolbar includes buttons
for some of the most common commands in DOE Wisdom.  A check mark appears next to the menu item
when the Toolbar is displayed.  The toolbar is displayed across the top, bottom, or either side of the
application window or as a floating window anywhere on the display screen.  The toolbar provides quick
mouse access to many tools used in DOE Wisdom. 

The Toolbar can be moved to any of the four sides of the Project window by clicking a blank space within
the toolbar and dragging it to wherever you want it positioned.  While dragging the Toolbar it shows an
outline of its shape and position.  As you get close to an edge of the application window the Toolbar will
change shape to indicate it is dropped in this position and it will dock to this edge of the window.
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The Status Bar command allows the user to display and hide the Status Bar.  The Status Bar describes the
action to be executed by the selected menu item or depressed toolbar button, and keyboard latch state.  A
check mark appears next to the menu item when the Status Bar is displayed.  The Status Bar is displayed
at the bottom of the DOE Wisdom window. 

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate
through menus.  This area similarly shows messages that describe the actions of toolbar buttons as you
move the mouse cursor over them.

The Project View menu also allows the user to activate various windows.  If the Message Window is
selected in the Project View menu, the Message window will be activated.  If the Message window is not
available, one will be opened.  After selecting this command the Message window will become the current
window.  Other windows that can be activated from the Project View menu include:

Linked Document
Design Window
Design Report Window
Worksheet Window
Data Window
Graph Window
Statistics Window

Help Menu
Click Help on the menu bar.  The following options will appear:

Figure 1-7

The Project Help command allows the user to display help for the project.

The Help Topics command allows the user to view contents, index, and find help features.
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The License command allows the user to obtain the site key specific for their computer.  
DOE Wisdom requires a site key.  Please e-mail launsby@aol.com or call Launsby Consulting at  719-
282-1143 within 15 days of loading the software.  If a site key is not entered within 15 days, the software
will no longer function.

NOTE: We have found that the most efficient way to take care of this is to have the user e-mail us your
site code.  To do this:

1. Load DOE Wisdom
2. Select Help from the menu selections.
3. Select License from the Help menu.
4. In the Software License screen you will see a Site Code section.  Highlight the Site

Code number and type CTL C.  (This will copy the site code to the Clipboard.)
5. Open your e-mail account and send a message to launsby@aol.com.  In the text field

type CTL V. (This will paste the Site Code from the clipboard.)
6. Launsby Consulting will e-mail back you site key with instructions.

NOTE: If you do not have an e-mail account, site codes can be faxed to Launsby Consulting at 719-282-
3099.

The About Wisdom command allows the user to view DOE Wisdom version information.

Project Window Folders
Message Log Folder
This folder displays different levels of DOE Wisdom error messages.  When calling Technical Support,
these messages may be useful.

Notes Folder
This folder allows the user to enter pertinent information regarding the experiment.  Operator names, data
collection date, etc. may be recorded using this folder.

External Documents Folder
This folder displays all Excel, Word and PowerPoint documents that have been linked to a specific DOE
project.  If linked documents are defined and saved, data can be transferred between the documents and
DOE Wisdom with menu item selections.  This creates a very easy way to copy designs and data into
DOE Wisdom and to build final reports and presentations in Microsoft Word or PowerPoint.
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Double-click on the External Documents folder.  The Linked Document File Window will appear.  Under
File, select either New or Open.  If New is selected, the options shown in Figure 1-8 will be available.

 

Highlight the appropriate object type and click OK. The new, blank copy of the document type selected
will now open.  Select File/Save and name the document. Name the new document.  Select File/Save Link
to save the link to Wisdom.

Once a file has been linked to Wisdom, that file’s name appears under the External Documents folder.  

Figure 1-8


